
 

Document IP Gateway-xx_REV01.00_en Edition: 2022-11-22 
  
 

USER MANUAL 

Draco tera IP Gateway 
 
Functional Quick Setup Guide 
Series 480 

 

   

 

 

 

   
 



 

 

Introduction 

 

This manual contains important safety instructions as well as instructions for setting up the product and 
operating it. Read carefully through the User Manual before you switch on the product. Observe the general 
safety instructions (see chapter 2, page 8) and additional instructions in the respective chapters. 

 

Product Identification 
The model and serial number of your products are indicated on the bottom of our products. Always refer to this 
information when you need to contact your distributor or the support of IHSE GmbH (see chapter 11, page 42). 
 

Trademarks and Trade Names 
All trademark and trade names mentioned in this document are acknowledged to be the property of their respective 
owners. 
 

Validity of this Manual 
This manual applies to all products of the Draco tera IP Gateway. Please note the change log for this manual in 
chapter 15, page 46. 
The manufacturer reserves the right to change specifications, functions or circuitry of the series described here 
without notice. Information in this manual can be changed, expanded, or deleted without notice. You can find the 
current version of the manual in the download area of our website. 
 

Copyright 
© 2022. All rights reserved. This manual may not be reproduced in any manner without the prior written consent of 
the manufacturer. 
 

Available Documentation 

Name Format Description Provision 
User Manual PDF Provides an overview of the product together with technical 

data and safety instructions. 
Contains all instructions required to operate the product to a 
basic level. 

Download from 
website 

Quick Setup Print Provides a quick installation guide and safety instructions Contained in the 
scope of delivery 

 

Contact 
IHSE GmbH 
Benzstraße 1 
88094 Oberteuringen 
Germany 
phone: +49 7546-9248-0 
fax: +49 7546-9248-48 
e-mail: info@ihse.com 
website: https://www.ihse.com 
 
 

mailto:info@ihse.com
https://www.ihse.com/
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1 Important Information 
1.1 Purpose of this manual 
This manual describes the settings for using Draco tera IP Gateways with Draco vario IP Gateway CONs. This 
manual serves as a supplement to the Draco tera manuals. For comprehensive information about IHSE matrix 
systems, please refer to the Draco tera manuals. 
 

1.2 Firmware and Software 
The information in this manual refers to the latest extender firmware available at the date of manual release. Please 
refer to the change log (see chapter 15, page 46) for user manual updates. 
 

1.3 Symbols for Warnings and Helpful Information 
The meaning of the symbols used for warnings and helpful information in this manual is described below: 
 

 WARNING 

WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury. 
 

 CAUTION 

CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury. 

 

NOTICE 

NOTICE identifies information, if not observed, endangers the functionality of your device or the security of your 
data. 

 

 This symbol indicates instructions for procedures recommended by the manufacturer for an effective utilization of 
the device potential. 
 

 This symbol indicates information about special features on the device or when using device and function 
variants. 
 

1.4 Terms and Spellings 
Uniform terms and spellings are used in this manual for better readability or easier assignment. 
The following spellings are used for products and system descriptions: 

Term Description 
Tera Tool Management software 

Source Computer, graphics card (USB, video, audio, data) 

Sink Console (monitor, keyboard, mouse, video, audio, data) 

CPU Unit Encoder to connect to the source. 

CON Unit Decoder to connect at the peripherals. 

IP Gateway Draco tera IP Gateway, a Draco tera matrix containing an IP Gateway board 

IP Gateway CON Draco vario IP Gateway CON, a Draco vario extender module (decoder) containing the IP 
Gateway technology 
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The following spellings are used for keyboard commands: 

Keyboard command Description 
key Key on the keyboard 

key + key Press keys simultaneously 

key, key Press keys successively 

2x key Press key quickly, twice in a row (like a mouse double-click) 
 
The following spelling is used for, e.g., descriptions of editing files or updating firmware: 

Keyboard command Description 
Config.txt E.g., file name 
#CFG E.g., file content 

 
The following spellings are used for software descriptions: 

Spelling Description 
Bold print Description of terms that are used in the management software, e.g., menus and buttons 

Bold print > Bold print Management software: selection of a menu item in the menu bar or the toolbar, e.g., 
Extras > Options 

 

Mouse button Description 
Left mouse button Primary mouse button* (default in most operating systems) 

Right mouse button Secondary mouse button* 

* Unless you have customized your mouse settings in the used operating system. 

Descriptions containing "click", "mouse click" or "double-click" each means a click with the primary (left) mouse 
button. If the right mouse button has to be used, this is explicitly declared in the description. 

 

1.5 Intended Use 
The IP Gateway is used to establish connections via IP from consoles (monitor, keyboard, mouse, and other 
peripheral devices) to various sources. 
The 10G IP Gateway board, available for Draco tera enterprise and Draco tera flex can be configured for eight 1G 
KVM channels to connect to other IP Gateways or to IP Gateway CONs for transmitting KVM, audio and data signals. 
The connection between the IP Gateways or between an IP Gateway CON and a network switch can be made by 
10G fiber cables.  
 

NOTICE 

Interferences when the immunity limit values are exceeded 
If the limit values listed in EN55024 are exceeded, reliable and fault-free functioning of the devices cannot be 
guaranteed. 

 

NOTICE 

Radio interference in a domestic environment 
This is a Class A product. In a domestic environment, this product may cause radio interference in which case the 
user may be required to take adequate measures. 
 Follow the safety and installation instructions given in this manual. 
 Use connection cables according to the specifications for the length and type given in this manual. 
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1.6 Certificates/Directives 
1.6.1 North American Regulatory Compliance 
This equipment has been found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment 
is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his own expense. 
Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 
authority to operate the equipment. 
Shielded cables must be used with this equipment to maintain compliance with radio frequency energy emission 
regulations and ensure a suitably high level of immunity to electromagnetic disturbances. 
All power supplies are certified to the relevant major international safety standards. 
 

1.6.2 EU Declaration of Conformity 
Please find the EU Declaration of Conformity for the device under: 
www.ihse.com/eu-declaration-of-conformity 
A copy of the original, product-specific EU Declaration of Conformity can be provided upon request. For contact 
details, see page 2 of this manual. 
 

1.6.3 WEEE 
The manufacturer complies with the EU Directive 2012/19/EU on the prevention of waste electrical and electronic 
equipment (WEEE). 
The device labels carry a respective marking. 
 
  

http://www.ihse.com/eu-declaration-of-conformity
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2 Safety instructions 
To ensure reliable and safe long-term operation of your device, please note the following guidelines: 
 Read this user manual carefully. 
 Read the manual for the chassis in which the extender modules are installed. The instructions, safety and 

warning notes contained therein must also be observed. 
 Only use the device according to this user manual. Failure to follow the instructions described can result in 

personal injury, damage to the device, or endanger the security of your data. 
 Take any required ESD precautions. 
 

Installation Location 
While operating the device can get warm. Damage to the device can occur in a damp environment. 
 Use the device only in dry, indoor environments. 
 Use the device only in a room with adequate ventilation. 
 Place the device at a sufficient distance from the operator. 
 

Connection 
 Check the device for visible damage before connecting it. 
 Only connect the device if the device and the ports are not damaged. 
 Only use cables supplied by the manufacturer or cables that comply with the technical specification, see 

chapter 10, page 39. 
 Only connect the device to KVM devices using the interconnecting cable - not to other devices, particularly not to 

telecommunications or network devices. 
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3 Consignes de Sécurité 
Pour garantir un fonctionnement fiable et sûr de votre périphérique à long terme, veuillez respecter les directives 
suivantes : 
 Lisez attentivement ce manuel d'utilisation. 
 Lisez le manuel d'utilisation du châssis dans lequel les modules d'extension sont installés. Les instructions, les 

consignes de sécurité et les avertissements qu'il contient doivent également être respectés. 
 N'utilisez le périphérique que conformément à ce manuel d'utilisation. Le non-respect des instructions décrites 

peut entraîner des blessures corporelles, endommager le périphérique ou mettre en danger la sécurité de vos 
données 

 Prenez toutes les précautions nécessaires contre les décharges électrostatiques. 
 

Emplacement de l'installation 
Pendant le fonctionnement, le périphérique peut chauffer. Le périphérique peut être endommagé dans un 
environnement humide. 
 N'utilisez le périphérique que dans un environnement sec et intérieur. 
 N'utilisez le périphérique dans un lieu correctement ventilée. 
 Placez le périphérique à une distance suffisante de l'opérateur. 
 

Connexion 
 Avant de connecter le périphérique et les unités d'alimentation, vérifiez qu'ils ne présentent pas de dommages 

visibles. 
 Seulement connectez le périphérique que si le périphérique et les ports ne sont pas endommagés. 
 Seulement utilisez des câbles fournis par le fabricant ou des câbles conformes aux spécifications techniques, 

voir chapitre 10, page 39. 
 Ne connectez le périphérique qu'à des périphériques KVM à l'aide du câble d'interconnexion - pas à d'autres 

périphériques, en particulier pas à des périphériques de télécommunications ou de réseau. 
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4 Description 
4.1 System Overview IP Gateway 
The current Draco tera flex allows to configure one of the two 10G interfaces for using as IP Gateway with eight IP 
KVM channels per rack unit. 

4.1.1 Installation Example - Matrix System with IP Gateway Board 

 

 

Fig. 1 Example 1 - Matrix system installation with IP Gateway board 
 

1 Sources 
2 CPU Units 
3 Draco tera flex, with 10G IP Gateway board, 

configurable for eight 1G KVM channels 

4 Single-Mode Fiber LC Duplex for up to eight 
1G KVM channels 
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4.1.2 Installation Example - Matrix Grid with two Matrices connected via IP Gateway 
Board 

 

 

Fig. 2 Example - Matrix Grid Installation with two Matrices connected via IP Gateway Board 
 

1 Draco tera flex, with 10G IP Gateway board,  
configured for eight 1G KVM channels 

2 10G straight fiber cable with eight 1G KVM channels 

3 Draco tera flex, with 10G IP Gateway board, 
configured for eight 1G KVM channels 
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4.1.3 Installation Example - Matrix System with IP Gateway CONs connected via IP 
Gateway 

  
Fig. 3 Example - Matrix system with IP Gateway CONs connected via IP Gateway 
 

1 Draco tera flex, with 10G IP Gateway board,  
configured for eight 1G KVM channels 

2 10G straight fiber cable with eight 1G KVM channels 
3 Network switch 

4 4x 10G network cable 
5 Distributed network 
6 IP Gateway CONs 
7 Consoles 
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4.1.4 Installation Example - Matrix Grid with two Matrices and IP Gateway CONs 
connected via IP Gateway 

 

 

Fig. 4 Matrix Grid with two matrices and IP Gateway CONs connected via IP Gateway 
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4.2 Product Types 
4.2.1 Draco tera flex Grid Cat X 1G and Fiber 1G 
Part No. Description 
K480-C32G Draco tera flex KVM Matrix 32 Ports + Grid, Cat X 1G, from October 2022 

K480-F32G Draco tera flex KVM Matrix 32 Ports + Grid, Fiber 1G, from October 2022 

F480-G Draco tera flex IP Gateway Module Fiber 10G 
 

4.2.2 IP Gateway Board for Draco tera enterprise 
Please contact the sales team for availability (estimated October 2022). 

Product type Description 
480-IPG Draco tera enterprise IP Gateway board 

- for transmission of up to 8 KVM connections @ 1G 
- configurable for Grid und IP console connectivity via IP L3 
- backward compatible to L1 Grid using separate FW 
- 2x SFP+ interface 
- 1x 10G SFP+ Single-Mode LC ≤ 10 km 

 

4.3 Accessories 
Part. No. Description Interface 
459-1C SFP, bidirectional, 1G Cat X, 1G 

459-1S SFP single-mode, LC duplex, bidirectional, 1G Fiber, 1G 

459-10X SFP single-mode, LC duplex, bidirectional, 10G,  
compatible with 3G fiber extender modules 

Fiber, 10G 
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5 Access Options 
You have following options to configure and/or operate extender modules: 

Access option Description 
Command Mode and 
Keyboard commands  

The command mode allows several functions to be controlled by keyboard commands 
during normal use.  

Tera Tool Firmware updates for extender modules and settings for IP Gateway connection can be 
performed via the management software. 
The management software is available as a single executable program file that does not 
require an installation. The management software can be downloaded from the link 
https://www.ihse.com/software. 
Advanced settings can be configured on the Draco tera operating system using the 
management software: 
• Advanced configuration 
• Extended monitoring options 
• System update (firmware update) 
• Local backup option 
• Documentation 

 

5.1 Command Mode 
To start the command mode, use a keyboard sequence (Hot Key) at the keyboard of a CON Unit plugged in a 
KVM device. The command mode can also be called up using a keyboard with USB HID interface connected to the 
R474-BXH add-on module. 
To exit the command mode, press Esc. 

NOTICE 

While in command mode, 
 the Caps Lock and Scroll Lock LEDs on the keyboard are flashing, 
 the USB HID devices are not operable, mouse and keyboard functions are deactivated, 
 only selected keyboard commands are available. 

 
 

 If there is no keyboard command entered within 10 seconds after activating the command mode, it will be 
deactivated automatically. 
 
The following keyboard commands are used to enter, and to exit the command mode, and to change the Hot Key. 

Function Keyboard command 
Start the command 
mode 

2x Left Shift (Hot Key, factory setting) 

Exit the command 
mode 

Esc and also Left Shift + Esc, if necessary 

Change the Hot Key current Hot Key, c, new Hot Key Code, Enter 
 
  

https://www.ihse.com/software
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NOTICE 

In a combined KVM matrix/U-switch configuration, select different Hot Keys for the connected extender modules, 
e.g., 2x Left Shift for access to the matrix and e.g., 2x Right Shift for access to the U-Switch. 

 

 Hot Keys currently can only be changed at the console and only for that console. 
 

Hot Key Code 
The Hot Key to start the command mode can be changed. The following table lists the Hot Key codes for the 
available Hot Keys. 

Hot Key Code Hot Key 
0 Freely selectable, except Esc, Del and Enter 

2 2x Scroll 

3 2x Left Shift (default) 

4 2x Left Ctrl 

5 2x Left Alt 

6 2x Right Shift 

7 2x Right Ctrl 

8 2x Right Alt 
 

Change the current Hot Key via Hot Key Code (exemplary) 
To change the current Hot Key to, e.g., 2x Left Alt, enter Hot Key, c, 5, Enter. 
 

Set a freely selectable Hot Key (exemplary) 
To set a freely selectable Hot Key (e.g., 2x Space), enter Hot Key, c, 0, Space, Enter. 

 Keyboard commands are fixed to the position of the keys on the keyboard. Keyboard mapping tables may vary for 
country-specific layouts. 

 Note the key position of a freely defined Hot Key when changing the keyboard layout, e.g., from QWERTZ to 
AZERTY. E.g., if defining 2x a as Hot Key on a German or US keyboard layout, the French keyboard layout 
(AZERTY) requires then 2x q as Hot Key to be pressed instead 

 

Reset the Hot Key 
To set a Hot Key back to default settings, press Right Shift + Del within 5 s after switching on the CON Unit or 
plugging in a keyboard. 
The Hot Key is set back to Left Shift. 
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5.2 Control Options via Management Software 
5.2.1 Management Software Menu Structure 

 The main user interface elements for options and functions of the management software are described in this 
chapter. This allows to keep the user manual clear. Further options and functions are explicitly declared in the 
respective chapters. 
 

 
The menu structure of the management software is subdivided into several sections: 

 

 

 

Fig. 5 Management software Menu structure 
 

1 Menu bar 
2 Toolbar 
3 Tab bar (shows connections or configurations) 
4 Task area 
5 Task menu 
6 Task menu item 

7 Status bar (shows config version, activated Edit 
Mode and online mode) 

8 Working area 
9 Tab bar (for additional menus) 
10 Buttons 

 
 

The following control element is included in the menus: 

Designation Element Description 
Checkbox  Function is not active, disabled by default or by mouse click 

 Function is active, enabled by default or by mouse click 
 
The following actions are available in most of the menus: 

Button Function 
Apply Confirm changes (temporary storage of the active configuration in the volatile memory of 

the matrix). 

Cancel Reject changes. 
 
  

8 

10 

9 

 

  

 
1 
2 
3 

5 

4 

6 

7 
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Information for Operating and for Support Functions 
The operation of the management software is intuitive and corresponds to the user interface of common operating 
systems. 
The management software contains its own support function. The integrated help texts in the working area of the 
management software can be activated or deactivated by ticking the checkbox in the upper right corner. Auxiliary 
names (tooltips) for the menu items can be activated under Extras > Options on the Style tab. 
 

5.2.2 Management Software Toolbar 
Some functions are only available if a connection to the matrix has been established (online mode). The respective 
functions are colored if available. 

 

 

Fig. 6 Management software Toolbar 
 

1 Load a locally saved configuration 
2 Save a configuration locally 
3 Reload the current configuration 
4 Connect to the matrix 
5 Disconnect from the matrix 
6 Activate/deactivate the edit mode 
7 Save the active configuration on the matrix  

(online) 
8 Download and show a predefined configuration saved 

on the matrix (online) 

9 Upload a predefined configuration on the matrix 
(online) 

10 Monitoring (online) 
11 Flash update for single devices 
12 Overview of devices in the subnet (online mode) 
13 System check 
14 Save status locally (online mode) 

 

5.2.3 Management Software Mouse Control 
The following mouse commands are selectable for menu functions: 

Mouse command Function 
Left mouse button Select menu, select function, open drop-down menus, enter input field, activate/deactivate 

option checkboxes, etc. 

Double-click left mouse 
button 

Open function specific selection menus 

Right mouse button Open context specific selection menus 
 
  

1      2      3        4        5              6            7            8         9        10          11         12           13           14 
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5.2.4 Management Software Keyboard Control 
The following keyboard commands are available for the navigation and configuration within the menus: 

Keyboard command Function 
Left Arrow Cursor to the left 

Right Arrow Cursor to the right 

Up Arrow Line up 

Down Arrow Line down 

Page Up In input or status menus with more than one page: previous page 

Page Down In input or status menus with more than one page: next page 

Tab In input menus: previous field 

Left Shift + Tab In input menus: next field 

Spacebar • Switch in selection fields between two conditions (check mark or not). 
• Open already marked fields with editing or selecting possibility. 

Enter • Select menu item 
• In menus: save data 

Ctrl + Tab • Leave tables 
• Jump from tables into the next field 

Ctrl + Left Shift + Tab • Leave tables 
• Jump from tables into the previous field 

 

 Several functions within the menus in the menu bar can be executed with the provided keyboard commands (e.g., 
press Ctrl + s to execute Save) that are listed to the right of the respective menu item. 
 

5.2.5 Management Software Reload Options 
The information about the current configuration of the matrix, shown in the management software, can be reloaded in 
different ways: 

• Press F5 on the used keyboard. 

• Click Reload in the toolbar. 

• Click Edit >Reload in the drop-down menu of the menu bar. 

• To activate the automatic reload option, tick the Automatic Reload checkbox in the right panel of the 
View >Matrix menu under Options. 

 

5.2.6 Management Software Context Function 
The management software offers several context functions that support user-friendly and effective operation. The 
context functions are described in the respective chapters. 

Context function Action Results 
Execute context 
function 

Click with the right mouse button on a field. A context menu opens and displays 
functions available for the corresponding 
filed (if existing). 

Click with the left mouse button on the 
desired function. 

The desired function is executed. 
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5.2.7 Management Software Sort Function 
Lists and tables in the management software offer a sorting function for fast and smooth search. An active filter is 
indicated by an arrow in the header. 

Sort function Action Results 
Ascending sort Click with the left mouse button once on the 

header of the column to be sorted. 
• The column is sorted in ascending order. 
• The sorting of status is indicated by an 

arrow pointing upwards. 

Descending sort Click with the left mouse button twice on the 
header of the column to be sorted. 

• The column is sorted in descending 
order. 

• The sorting is displayed by an arrow that 
points downwards. 

Cancel sort Click with the left mouse button once or 
twice on the head of the sorted column. 

The displayed arrow disappears. 

 

5.2.8 Management Software Filter Function 
Lists and tables in the management software offer a filter function that supports a fast and smooth search. The filter 
entry field is located above the header. An active filter is indicated by a green filter symbol in the filter entry field. 

Filter function Action Results 
Activate the filter Click with the left mouse button in the filter 

entry field above the header. 
Write the word or part of a word to be 
filtered. 
It is possible to search a combination of two 
words with space between. 

• The filter results are shown immediately. 
• The filter symbol is displayed in green. 

Clear the filter Delete the text in the filter entry field. • The list or table shows the complete 
content. 

• The filter symbol is displayed in gray. 
 
  



Draco tera IP Gateway Access Options 

21 

5.2.9 Management Software Report Function 
The management software is equipped with a report function that shows the current switching status and all relevant 
parts of the matrix configuration in a PDF file. 

 The report function can be used in both online and offline mode of the management software. 
 
To create a report, proceed as follows: 
1. Select File > Report... in the menu bar. 

A selection dialog appears. 
2. Select contents that should be included in the report (Matrix View, EXT Units, CPU Devices, CON Devices and 

Users, etc.). 
3. Click Next > > to confirm the selection. 

 
Fig. 7 Management software File - Report - Define Content 
 
  



Access Options Draco tera IP Gateway 

22 

4. Go to the preferred location for storage of the report. 
5. Click Finish to confirm the report. 

The report will be created as a PDF file. 

 

 

Fig. 8 Management software File - Report - Save Report 
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6 Installation 
NOTICE 

Please verify that interconnect cables, interfaces, and handling of the devices comply with the requirements (see 
chapter 8, page 35). 

 

 First-time users are recommended to set up the system in a test environment that is limited to a single room. This 
makes it easier to identify and solve any cabling problems, and experiment with your system more conveniently. 
 

6.1 Setting up the Hardware 
Requirements 
The matrix system has been connected and basically configured according to the Draco tera user manual: 

• The hardware of the matrix system has been physically connected (matrix, controller board(s), I/O boards, 
CON Units, CPU Units, sources, and sinks, etc.). 

• The initial configuration has been set (system settings, e.g., network settings). 

• The logical devices have been created and configured (EXT Units and CON/CPU Devices, etc.). 

• A status of the matrix configuration has been stored as backup file. 
 

6.1.1 Connecting two Matrices via IP Gateway Board 
 Connect the IP Gateway board of the matrices via 10G fiber cable. 

To set up the IP Gateway connection see chapter 7.1, page 30. 
 

6.1.2 Connecting an IP Gateway CON via Network Switch to the IP Gateway 
1. Connect a network switch via via 10G fiber cable to an IP Gateway. 
2. Note the network settings (see chapter 8.3, page 37) and set the network connection. 
3. To set up the IP Gateway connection see the user manual for the Draco vario IP Gateway CON. 
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6.2 Connecting the Management Software with the Matrix 
NOTICE 

Connection to the matrix blocked 
Synchronization directories or offline directories require special attention regarding the firewall settings, e.g., 
Windows: roaming directories. If blocked by the firewall, no connection to the matrix can be established. 
 Save the management software in a locally available directory. 

 

6.2.1 Installing the Management Software 
The management software is available as a single executable program file that does not require an installation. 

Requirements 
If you want to use the management software on Windows operating systems with integrated Java Runtime, the 
following requirements must be fulfilled: 

Computer/Software/Network Requirements/Recommendations 
Free memory RAM Recommended: 1 GB 

Operating system Microsoft Windows 8, Windows 8.1, Windows 10, Windows 11 

Management software 
with integrated Java 
Runtime 

Tera Tool Downloaded from https://www.ihse.com/software 

Network connection - Available between computer and matrix. 
 
If you want to use the management software without integrated Java Runtime, the following requirements must be 
fulfilled: 

Computer/Software/Network Requirements/Recommendations 
Free memory RAM Recommended: 1 GB 

Operating system Microsoft Windows 8, Windows 8.1, Windows 10, Windows 11 

macOS macOS 10.14 (Mojave) or higher, Intel platform 

Specification Java Installed: Oracle Java Runtime Environment (JRE) 1.8.x or higher 
Strongly recommended: Oracle Java 1.8 update 152, or higher. 
(https://adoptopenjdk.net, https://github.com/ojdkbuild/ojdkbuild 

Management software Tera Tool Downloaded from https://www.ihse.com/software 

Network connection - Available between computer and matrix 
 

 Contact your system administrator concerning JRE and network connection. 
 
  

https://www.ihse.com/software
https://adoptopenjdk.net/
https://github.com/ojdkbuild/ojdkbuild
https://www.ihse.com/software
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6.2.2 Setting up Network and Firewall Releases 
Releasing Network Ports 
The following ports are used by the matrix depending on the configuration and have to be released at the security 
gateway if necessary. The ports will only have to be released if you want to use the respective function. 

Function Port 
FTP 21/TCP 

DNS 53 

SNTP 123/UDP 

SNMP 161/162, both UDP 

LDAP 389 (636 for SSL) 

Syslog 514/UDP 

Communication 52000 to 52100 

API 5555/TCP (5565 for SSL) 

Broadcast 5556/UDP (5566 for SSL) 

Matrix Grid 5557/TCP (5567 for SSL) 
 

Releasing Java Application in the Firewall 
If using the management software, the Java application (file javaw.exe) has to be released in the firewall settings to 
use the management software. Contact your administrator to configure the firewall settings accordingly. 
Using the management software with integrated Java Runtime, a request of the operating system could appear, e.g., 
if opening the Device Finder. 
 

6.2.3 Connecting the Matrix to the Computer 
NOTICE 

For a connection between computer and matrix via switch or hub, parallelly assembled network cables are 
required. 
 Only use a network connection between computer and the matrix that is not primarily used for streaming audio 

or video data. 
 
 Connect the network cable to the RJ45 ports of the computer and the controller board of the matrix. 
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6.2.4 Starting the Management Software 
 Run the management software by a double-click on the program icon on the desktop or the file in the directory. 

The management software starts in offline mode. 

 
Fig. 9 Management software Landing page in offline mode 
 
There are two options to connect to a matrix. 

• Via a known IP address 

• Via Device Finder 
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6.2.5 Connecting to the Matrix with known IP Address 
 At least power user rights are required, and the API function have to be enabled. 

 

 Up to 16 connections between the matrix and the management software can be established at the same time due 
to a limitation of available sockets. 
 
To connect to a matrix when the IP address is known, proceed as follows: 
1. Run the management software. 
2. Click Connect in the tool bar. 

A login dialog appears. 
3. Enter the IP address according to the network configuration of the matrix. 

By default, the IP address of the matrix is 192.168.100.99 and DHCP is deactivated. 
4. Enter the username and password of the administrator. 

By default, the username is admin, and the password of the administrator is admin. 
5. Click Login to confirm your entries. 
 

 
Fig. 10 Management software dialog Connect 
 

 The data must be entered each time the network connection is re-established. 
Alternately, the data can be entered and stored in the management software under Extras > Options. 
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6.2.6 Connecting to the Matrix via Device Finder 
 At least power user rights are required, and the API function have to be enabled. 

 

 Up to 16 connections between the matrix and the management software can be established at the same time due 
to a limitation of available sockets. 
 
The Device Finder offers the possibility to find all matrices that are in the same subnet. This is useful, e.g., if the IP 
address of a specific matrix is unknown and should be accessed via IP. 

 

 

Fig. 11 Management software menu Device Finder 
 
The following device information is shown in the Device Finder: 

Information Description 
Broadcast/Multicast Search parameters for finding devices. 

Search via broadcast: 255.255.255.255 (default). 
Input for search within a multicast group: multicast address 

Device Name of the device 

Name Name of the active configuration 

IP Address Current IP address of the device 

MAC Address MAC address of the device 

Type Type of the device 
 

 The last column of the Device Finder can be used to connect to the respective matrix directly clicking Connect. 
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To find and connect a device, proceed as follows: 
1. Click Device Finder in the tool bar. 
2. For searching within a multicast group, enter the multicast address. By default, the search is set via broadcast: 

255.255.255.255. 
3. Click Connect in the last column of the Device Finder to establish direct connection to the respective device 

within the same subnet. 
4. Enter the username and password of the administrator. 

By default, the username is admin, and the password of the administrator is admin. 
5. Click Login to confirm your entries. 
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7 Configuration 
The configuration of the IP Gateway board is saved on the IP Gateway board and is available after installation in 
another matrix. 
 

7.1 Configuring IP Gateway Connections 
The configuration of IP Gateways and the connection via IP to another IP Gateway is set in this menu. Each IP 
Gateway board is internally managed with eight ports for up to eight connections over a 1G channel to establish 
connections to another IP Gateway boards or to an IP Gateway extender. To set an IP Gateway connection between 
two matrices, it is necessary to configure both matrices. 

 

 

Fig. 12 Management software menu System Settings - IP Gateway 
 

7.1.1 Setting an IP Gateway Connection 
 We strongly recommend setting IP Gateway connections only via Master Matrix. 

 
To set a new IP Gateway connection, proceed as follows: 
1. Connect to the Master Matrix. 
2. Click System Settings > IP Gateway in the task area. 
3. Click Activate Edit Mode in the toolbar. 
4. Click the slot with the IP Gateway board under Slot for which an IP Gateway connection has to be set. 
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5. By default, the channel type is set to Grid. If the channel type in the line of a source port that has to be used for 
Matrix Grid connection via IP Gateway is set to EXT Unit, double-click on the corresponding selection box of the 
port to be configured within the Type column and select Grid. 

 

 

Fig. 13 Management software menu System Settings - IP Gateway - Select Channel Type 
 

6. Double-click in the respective Select Grid Channel field. 
A drop-down menu is opened listing all available ports that are configured for use as grid line. 

7. Click on the desired port in the list. 

 

 

Fig. 14 Management software menu System Settings - IP Gateway - Select Grid Channel 
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8. The data of the selected grid port is read and automatically entered in the selected channel line in this menu. 

 

 

Fig. 15 Management software menu System Settings - IP Gateway - Selected Grid Channel 
 

9. Click Apply to confirm the selection. 
The data of the selected Master Matrix channel is read and send to the selected channel of the IP Gateway 
board to be connected. The data of the Master Matrix channel is automatically entered in the line of the selected 
grid port. 
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Manual connection 
To establish connection by manually entering the required data, proceed as follows: 
1. Connect to the Sub Matrix. 
2. Click System Settings > IP Gateway in the task area. 
3. Click Activate Edit Mode in the toolbar. 
4. Select the slot to be connected and note the data of the IP Gateway in the Port section (IP address and MAC 

address) and the port of the desired channel in the Channels section. 
5. Connect to the Master Matrix. 
6. Click System Settings > IP Gateway in the task area. 
7. Select the slot to be connected and note the data of the required channel: IP address, MAC address and what 

ports are available. 

 

 

Fig. 16 Management software menu System Settings - IP Gateway - Enter destination data 
 

8. Double-click in the respective Destination IP Address field and enter the destination IP address of the IP 
Gateway board of the Sub Matrix. 

9. Press Enter to confirm the destination IP address. 
10. Double-click in the respective Destination Port field and enter the destination port of the IP Gateway board of 

the Sub Matrix. 
11. Press Enter to confirm the destination port. 
12. Double-click in the respective Destination MAC Address field and enter the destination MAC address of the IP 

Gateway board of the Sub Matrix. 
13. Press Enter to confirm the destination port. 
14. Click Apply to confirm entries. 
15. Return to the Sub Matrix IP Gateway menu and enter the data of the Master Matrix by repeating the steps 8 to 14. 
16. Click Deactivate Edit Mode in the toolbar. 

 After entering the destination IP address and destination port, the MAC Address can be retrieved automatically by 
clicking Apply and clicking Reload. 
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7.1.2 Deleting an IP Gateway Connection 
 We strongly recommend deleting IP Gateway connections only via Master Matrix. 

 
To delete an IP Gateway connection, proceed as follows: 
1. Connect to the Master Matrix. 
2. Click System Settings > IP Gateway in the task area. 
3. Click Activate Edit Mode in the toolbar. 
4. Click the slot with the IP Gateway board under Slot of which an IP Gateway connection has to be deleted. 

5. Click the red cross  in the respective line to delete the connection of an IP Gateway board. 
The connection settings has been deleted on both IP Gateways. 

 It is necessary to delete the connection in both matrix configurations. We recommend connecting to the second 
matrix to check if the data of the connection has been removed. If not, click the red cross  in the respective line to 
delete the data of the connection. 
 
 

6. Click Deactivate Edit Mode in the toolbar. 
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8 Maintenance 
8.1 Querying the Device Status via Management Software 
The connections to the matrix are displayed in this menu. 
 Click View > Matrix in the task area to display the current connections. 

Slots with IP Gateway boards are designated in the matrix view (1). 

 

 

Fig. 17 Management software menu View - Matrix 
 

 Functions, colors, and symbols used in the Grid Port View are explained in the matrix user manual. 
 
  

1 
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8.2 Querying the Port Status of a Matrix Grid 
In this menu the connections and the switching status between the various CON and CPU Devices are shown within 
the Matrix Grid. 
The port view is divided into the different Grid matrices. As a result, each matrix is displayed in an optimized view of 
24 ports per line to be able to also show a larger number of ports. 
 Click View > Port in the task area to display the current connections. 

 

 

Fig. 18 Management software menu View - Matrix 
 

 Functions, colors, and symbols used in the Grid Port View are explained in the matrix user manual. 
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8.3 Querying the Network Status 
The current network status is displayed in this menu. 
1. Click System Settings > Network in the task area to query the network configuration. 

 

 

Fig. 19 Management software menu View - Matrix 
 
2. Click a network port of the controller board with the left mouse button. 

The corresponding network status will be displayed in the panel on the right side of the working area. 
The available information can be faded in or hidden by pressing the left mouse button on the "plus" or "minus" 
icon. 

 

The following information is available: 

Port color Description 
IP Address IP address if DHCP is not active. 

Subnet Mask Subnet mask if DHCP is not active. 

Gateway Gateway address if DHCP is not active. 

MAC Address MAC address. 
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9 Troubleshooting 
For more help in case of problems with the matrix, please refer to the Draco tera user manual. 

9.1 IP Connection Failure 
Diagnosis Possible reason Measure 
No Matrix Grid 
connection available. 

The destination type is set to EXT Unit.  Set the designation type to Grid. 

The destination data is wrong.  Check the designation IP address of both 
IP Gateway boards. 

 Check the designation port of both IP 
Gateway boards. 

 Check the designation MAC address of 
both IP Gateway boards. 

The IP Gateway assignment is only set in 
one of two matrices. 

 Set the IP Gateway assignment in both 
matrices. 
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10 Technical Data 
10.1 Interfaces 
10.1.1 RJ45 (Interconnect) 
Cat X devices offer a 1000BASE-T interface to establish an interconnection between Cat X devices. All four wire 
pairs are used in both directions. The cabling is suitable for a full duplex operation. 
 

10.1.2 Fiber SFP Type LC (Interconnect) 
The communication of fiber devices is performed via Gigabit SFPs that are connected to suitable fibers fitted with 
connectors type LC (see chapter 10.2.2, page 40). 

NOTICE 

The correct function of the device can only be guaranteed with SFPs provided by the manufacturer. 
 

NOTICE 

SFP modules can be damaged by electrostatic discharge (ESD). 
 Please consider ESD handling specifications. 

 

10.2 Interconnect Cables 
10.2.1 Cat X 

NOTICE 

Transmission problems 
Routing over an active network component, such as an ethernet hub, switch, or router is not allowed. Operation 
with several patch fields is possible. 
 Establish a point-to-point connection. 
 Avoid routing Cat X cables along power cables. 

 

NOTICE 

Exceeding the limit of the device class 
The use of unshielded Cat X cables with higher electromagnetic emissions/radiation can exceed the limit values for 
the specified device class. 
 Correctly install shielded Cat X cable throughout interconnection, to maintain regulatory EMC compliance. 

 

NOTICE 

Exceeding limit values for electromagnetic radiation 
The limit values for the electromagnetic radiation of the device are complied with if ferrites are mounted on both 
sides of all Cat X cables near the device. With installed ferrites, the devices meet the EU guidelines for 
electromagnetic compatibility. The operation of the devices without mounted ferrites leads to a loss of conformity 
with the EU directives. 
 Mount ferrites on both sides of all Cat X cables near the device to maintain regulatory EMC compliance. 
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Type of Interconnect Cable 
The extender modules require interconnect cabling specified for Gigabit Ethernet (1000BASE-T). The use of solid 
core (AWG24), shielded, Cat 5e (or better) is recommended. 

Type of cable Specification 
Cat X installation cable 
AWG24 

S/UTP (Cat 5e) cable according to EIA/TIA-568, standard 568-A or 568-B. Four pairs of 
wires AWG24. 
We recommend using standard 568-A, but standard 568-B is also supported. 

Cat X patch cable 
AWG26/8 

S/UTP (Cat 5e) cable according to EIA/TIA-568, standard 568-A or 568-B. Four pairs of 
wires AWG26/8. 
We recommend using standard 568-A, but standard 568-B is also supported. 

 

 The use of flexible cables (patch cables) type AWG26/8 is possible. However, the maximum possible extension 
distance is halved. 
 

Maximum Transmission Range for Video and USB HID Signals (End-to-End Connection) 

Type of cable Maximum transmission range 
Cat X installation cable 
AWG24 

140 m (460 ft) 

Cat X patch cable 
AWG26/8 

70 m (230 ft) 

 

10.2.2 Fiber 
NOTICE 

Transmission problems 
Routing over an active network component, such as an ethernet hub, switch, or router is not allowed. Operation 
with several patch fields is possible. 
 Establish a point-to-point connection. 
 Avoid routing Cat X cables along power cables. 

 

Type of Interconnect Cable* 

Type of cable Specification 
Single-mode 9 μm • Two fibers 9 μm 

• I-V(ZN)H 2E9 (in-house patch cable) 
• I-V(ZN)HH 2E9 (in-house breakout cable) 
• I/AD(ZN)H 4E9 (in-house or outdoor breakout cable, resistant) 
A/DQ(ZN)B2Y 4G9 (outdoor cable, with protection against rodents) 

Multi-mode 50 μm • Two fibers 50 μm 
• I-V(ZN)H 2G50 (in-house patch cable) 
I/AD(ZN)H 4G50 (in-house or outdoor breakout cable, resistant) 

* Cable notations according to VDE 
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Maximum Transmission Range for Video and USB HID Signals (End-to-End Connection) 

NOTICE 

Transmission ranges when using add-on modules with transparent USB 
When using L474/R474 add-on modules with transparent USB, the binding specifications stated in the data sheets 
of the add-on modules apply. 

 
Type of cable Bandwidth Maximum transmission range 
Single-Mode 9 μm 1G 10,000 m (32,808 ft) 

Single-Mode 9 μm 3G 5,000 m (16,404 ft) 

Multi-Mode 50 μm 
(OM3) 

1G/3G 1,000 m (3,280 ft) 

Multi-Mode 50 μm 1G/3G 400 m (1,312 ft) 
 

 When using single-mode SFPs with multi-mode fiber optic cables, the maximum transmission range can usually 
be doubled. 
 

Type of Connector 

Connector Type 
Plug-in connector LC-Connector 

 

10.3 Connector Pinouts 
10.3.1 RJ45 (Interconnect) 
Connector Pin Signal Pin Signal 

 

1 D1+ 5 D3- 

2 D1- 6 D2- 

3 D2+ 7 D4+ 

4 D3+ 8 D4- 
 

10.3.2 Fiber SFP Type LC (Interconnect) 
Connector Diode Signal 

 

1 Data OUT 

2 Data IN 
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11 Technical Support 
Prior to contacting support please ensure you have read this manual, and then installed and set-up your 
KVM extender as recommended. 

11.1 Support Checklist 
To efficiently handle your request, it is necessary that you complete a support request checklist (Download). Please 
ensure that you have the following information available before you call: 

• Company, name, phone number and email 

• Type and serial number of the device 

• Date and number of sales receipt and name of dealer if necessary 

• Issue date of the existing manual 

• Nature, circumstances, and duration of the problem 

• Components included in the system (such as graphic source/CPU, OS, graphics card, monitor, 
USB HID/USB 2.0 devices, interconnect cable) including manufacturer and model number 

• Results from any testing you have done 
 

11.2 Shipping Checklist 
1. To return your device, you need an RMA number (Return-Material-Authorization). Therefore, please contact your 

dealer. 
2. Package your devices carefully. Add all pieces which you received originally. Preferably use the original box. 
3. Note your RMA number visibly on your shipment. 
 

 Devices that are sent in without an RMA number will not be accepted. The shipment will be sent back without 
being opened, postage unpaid. 
 

 
  

https://www.ihse.com/wp-content/uploads/files/support/ihse-support-checklist.pdf
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12 Glossary 
The following terms are commonly used in this manual or in video and KVM technology. 

Term Description 
CON Device Logical object that summarizes several EXT Units of physical extender modules 

(CON Units) to switch more complex sink systems via matrix. 

CON Unit Decoder extender module to connect to the console (monitor(s), keyboard, and mouse; 
optionally also with USB 2.0 devices). 

Console Monitor, keyboard, mouse, media control, external switching solution, etc. 

CPU Device Logical object that summarizes several EXT Units of physical extender modules 
(CPU Units) to switch more complex source systems via matrix. 

CPU Unit Encoder extender module to connect to a source. 

Fiber Single-mode or multi-mode fiber cables. 

KVM Keyboard, video, and mouse. 

MTBF Mean Time Between Failure (MTBF) is measured in power-on hours and describes the 
system reliability. 

Multi-Mode 50 µm multi-mode fiber cable. 

SFP SFPs (Small Form Factor Pluggable) are pluggable interface modules for Gigabit 
connections. SFP modules are available for Cat X and fiber cables. 

Single-Mode 9 µm single-mode fiber cable. 

USB HID USB HID devices (Human Interface Device) allow users to interact with computers. There 
is no need for a special driver during installation. When connecting, the message “New 
USB HID device found” is reported. 
Typical USB HID devices include keyboards, mice, graphics tablets and touch screens. 
Storage, video, and audio devices are not USB HID devices. 
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15 Change Log 
This table offers an overview about the most important changes available, such as new functions, changed configuration or operation. 
 

Edition Date Firmware 
version 

Software 
version 

Chapter New functions/changes 

REV01.00 2022-11-22 Latest 
version 

V 5.1.4.0, 
2022-10-28 

- Initial user manual. 
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